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~/Dropbox/Teaching/Workshops/2020-gpl/01_welcome-tidyverse - RStudio
o - Oqz < ~ Go to file/function -~ Addins ~

Console Terminal Jobs

~/Dropbox/Teaching/Workshops/2020-gpl/01_welcome-tidyverse/

R version 4.0.0 (2020-04-24) -- "Arbor Day"
Copyright (C) 2020 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwinl7.0 (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type 'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
"citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
"help.start()' for an HTML browser interface to help.
Type 'q()' to quit R.
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Workshops > 2020-gpl > 01_welcome-tidyverse
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.Rhistory
00_phones.Rmd
01_getting-started.Rmd
02_data-basics.Rmd
03_visualize-data.Rmd
04_transform-data.Rmd
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gpl-welcome-tidyverse.Rproj

| README.Rmd
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Console

= - [ ] e _©o
# Go to file/function L~ ~ Addins ~ N 01_welcome-tidyverse ~
Console  Terminal Jobs = Environment  History Connections Tutorial = IS awa I I n yo u I

~/Dropbox/Teaching/Workshops/2020-gpl/01_welcome-tidyverse/ <L B # Import Dataset ~ ¥ = list - | (& ~

7} Global Environment ~

) [ ] [ ]
R version 4.0.0 (2020-04-24) -- "Arbor Day"
Copyright (C) 2020 The R Foundation for Statistical Computing I nS ru C Io nS
Platform: x86_64-apple-darwinl7.0 (64-bit) Environment is empty '

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type 'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale PTG v Brers l Bvieemrss . I ype ‘ od e h e re'

: : . : ; ) [x} - ,
R is a collaborative project with many contributors. itLNew foldey Dt pliRename #More
(Jiching > Workshops > 2020-gpl > 01_welcome-tidyverse (Rl

Type 'contributors()' for more information and
‘citation()' on how to cite R or R packages in publications. 4 Name Size Modifiec
o !

Type ‘demo()' for some demos, ‘help()' for on-line help, or ( Rhistory 95 B Jul 8,2
‘help.start()' for an HTML browser interface to help. [ @] 00_phones.Rmd 0B Jul 7, ) o
Type 'q()" to quit R. ©] 01_getting-started.Rmd 0B Jul 7,
N I @] 02_data-basics.Rmd 0B Jul 7, WI ru n I
@] 03_visualize-data.Rmd 0B Jul 7,
@ 04_transform-data.Rmd 0B Jul 7,
(=] cheatsheets
[ £ data
[ ][Rl gpl-welcome-tidyverse.Rproj 218 B Jul 8,
@) README.Rmd 0B Jul 7,
(] slides
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Your turn

- (]
o - 01; - A Go to file/function - - Addins ~ R/ 01_welcome-tidyverse ~
Console  Terminal Jobs = Environment  History Connections  Tutorial = y p e 2 I 2 I n e

~/Dropbox/Teaching/Workshops/2020-gpl/01_welcome-tidyverse/ =l | 7 Import Dataset ~ y’ List ~ | (& ~

7} Global Environment ~
R version 4.0.0 (2020-04-24) -- "Arbor Day"
Copyright (C) 2020 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwinl7.0 (64-bit) Environment is empty l

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type 'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale

e Press enter

© ) NewFolder | © Delete =|Rename 3 More ~ 3

R is a collaborative project with many contributors.

Type 'contributors()’ for more information and ching > Workshops > 2020-gpl > 01_welcome-tidyverse (R

‘citation()' on how to cite R or R packages in publications. & D Slize iodlified
Tt .
Type ‘'demo()' for some demos, 'help()' for on-line help, or [ ] ©7] .Rhistory 95 B Jul 8,2
‘help.start()' for an HTML browser interface to help. [ ] @] 00_phones.Rmd 0B Jul 7,2
Type 'q()’ to quit R. [} @] 01_getting-started.Rmd 0B Jul 7,
R I [} @) 02_data-basics.Rmd 0B Jul 7,
[} @] 03_visualize-data.Rmd 0B Jul 7,
[} @) 04_transform-data.Rmd 0B Jul 7,
[} 1 cheatsheets
[} £ data
[ ][Rl gpl-welcome-tidyverse.Rproj 218 B Jul 8,
[] @] README.Rmd 0B Jul 7,
[ 1 slides
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This is ephemeral though.

If you want to run this again, you'll have to type it again.

Store R code in a document instead
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Files pane

O -lopl- A Goto file/function e

Console  Terminal Jobs

~/Dropbox/Teaching/Workshops/2020-gpl/01_welcome-tidyverse/

R version 4.0.0 (2020-04-24) -- "Arbor Day"
Copyright (C) 2020 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwinl7.0 (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type 'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale
R is a collaborative project with many contributors.
Type ‘'contributors()' for more information and
‘citation()' on how to cite R or R packages in publications.
Type ‘'demo()' for some demos, 'help()' for on-line help, or

‘help.start()' for an HTML browser interface to help.
Type 'q()' to quit R.

7|

N 01_welcome-tidyverse ~

= Environment  History Connections  Tutorial =
2 [ 72 Import Dataset ~ ¥ = List + | (&~
7} Global Environment ~ Q
Environment is empty '
Files Plots Packages Help Viewer = ]
© ) NewFolder | © Delete =|Rename 3 More ~ @
(TJiching > Workshops > 2020-gpl > 01_welcome-tidyverse (Rl
A Name Size Modifiec
.Rhistory 95 B Jul 8,2
00_phones.Rmd 0B Jul 7,
01_getting-started.Rmd 0B Jul 7,
02_data-basics.Rmd 0B Jul 7,
03_visualize-data.Rmd 0B Jul 7,
04_transform-data.Rmd 0B Jul 7,
| cheatsheets
| data
gpl-welcome-tidyverse.Rproj 218 B Jul 8,
README.Rmd 0B Jul 7,
slides

All the files in your
current working
directory
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Your turn

- [ ]
Qo - 01; it A Go to file/function - - Addins ~ R/ 01_welcome-tidyverse ~ )
—
Console  Terminal Jobs = Environment  History Connections Tutorial =
—

~/Dropbox/Teaching/Workshops/2020-gpl/01_welcome-tidyverse/ =l | 7 Import Dataset ~ y’ List ~ | (& ~
7} Global Environment ~

R version 4.0.0 (2020-04-24) -- "Arbor Day"

Copyright (C) 2020 The R Foundation for Statistical Computing

Platform: x86_64-apple-darwinl7.0 (64-bit) Environment is empty l

started.qmd

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type 'license()' or 'licence()' for distribution details.

T —— ick on its name to

Natural language support but running in an English locale
R is a collaborative project with many contributors. 8 New Folder | @] Delete (3] Rename {a’ More ~ :
Type 'contributors()' for more information and ching > Workshops > 2020-gpl > 01_welcome-tidyverse Rl | ...
‘citation()' on how to cite R or R packages in publications. 4 Name Size podifice
open the file
Type ‘'demo()' for some demos, 'help()' for on-line help, or [ ] ©7] .Rhistory 95 B Jul 8,2
‘help.start()' for an HTML browser interface to help. [ ] @] 00_phones.Rmd 0B Jul 7,2
Type 'q()’ to quit R. [} @] 01_getting-started.Rmd 0B Jul 7,
R I [} @) 02_data-basics.Rmd 0B Jul 7,
[} @] 03_visualize-data.Rmd 0B Jul 7,
[} @) 04_transform-data.Rmd 0B Jul 7,
[} 1 cheatsheets
[} £ data
[ ][Rl gpl-welcome-tidyverse.Rproj 218 B Jul 8,
[] @] README.Rmd 0B Jul 7,
[ 1 slides

9/33



Source pane

[ ) ~/Drop! hin 0 020-gpl/01_v me-tid! RStudio
IR 2 | (A Coto fleffunction o - Addins - Docu ments
@ 01_getting-started.Rmd =0 Em
. & A & kit - - 3 Insert ~ I SRun ~ | % - | = 2
- open here
2 title: "Getting Started with R and RStudio"
3 output: html_document
4 s ---
5
6~ " {r setup} »
7 library(tidyverse)
gat
9
10 ~ ## R Markdown
File
11
12 This is an [R Markdown](http://rmarkdown.rstudio.com) file (it has a .Rmd file extension). <4
When you execute code within the file, the results appear beneath the code. @[
13
14 R code goes in **code chunks**, denoted by three backticks. Try executing this chunk by
1:4 E3 Getting Started with R and RStudio + R Markdown = O
Console  Terminal Jobs =M O

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
‘citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
‘help.start()' for an HTML browser interface to help.
Type 'q()' to quit R. )

g
T —
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O -yl =5 | A Go to file/function " -~ Addins ~
@ 01_getting-started.Rmd =0 Em
. > o e KDL @ Insert ~ SRun -~ | B - | = 2
= 3
title: "Getting Started with R and RStudio"
output: html_document
6~ " {r setup} 4
7 library(tidyverse)
gt
9
10 -~ ## R Markdown
File
11 )
12 This is an [R Markdown](http://rmarkdown.rstudio.com) file (it has a .Rmd file extension). &4
When you execute code within the file, the results appear beneath the code. [
13
14 R code goes in **code chunks**, denoted by three backticks. Try executing this ¢ |
1:4 Getting Started with R and RStudio +
Console  Terminal Jobs = ‘

~/Dropbox/Teaching/Workshops/2020-gpl/01_welcome-tidyverse/ O

R is a collaborative project with many contributors. @]
Type 'contributors()' for more information and M)
‘citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
‘help.start()' for an HTML browser interface to help.
Type 'q()' to quit R. U

d

Document format that
combines text and code

Acts like a notebook
for your analysis
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@] 01_getting-started.Rmd

=
& P OO0 @ Knit - - 3 Insert ~ FRun + G~ =
10§ ## R Markdown
11
12§ This is an [R Markdown](http://rmarkdown.rstudio.com) file (it has a .Rmd file extension).
When you execute code within the file, the results appear beneath the code.
13
14§ R code goes in **code chunks**, denoted by three backticks. Try executing this chunk by
clicking the *Run* button (a small green triangle) within the chunk or by placing your cursor
inside it and pressing *Ctrl+Shift+Enter* (or *Cmd+Shift+Enter* on Mac).
15
16~ " {r} = )
17 ggplot(data = mpg) +
18 geom_point(mapping = aes(x = cty, y = hwy), alpha = 0.2)
19~ °°°
A x

°
40-

X
> ee
X}

hwy

o0 e

[ X

L
o eoe
oo

e

Text
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@] 01_getting-started.Rmd

| A0 @ Knit - - 3 Insert ~
## R Markdown

10 ~

11
12

13
14

15
16
17
18
19

This is an [R Markdown](http://rmarkdown.rstudio.com) file (it has a .Rmd file extension).
When you execute code within the file, the results appear beneath the code.

clicking the *Run* button (a small green triangle) within the chunk or by placing your cursor
inside it and pressing *Ctrl+Shift+Enter* (or *Cmd+Shift+Enter* on Mac).

il |

A{r}
ggplot(data = mpg) +
geom_point(mapping = aes(x = cty, y = hwy), alpha = 0.2)

40-
e ¢
°
e o ¢
o e o
30- e © °
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Code
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@] 01_getting-started.Rmd

G | A QK - e
10 ~ ## R Markdown

11

12

13

14 R code goes in **code chunks**, denoted by three backticks. Try executing this chunk by
clicking the *Run* button (a small green triangle) within the chunk or by placing your cursor
inside it and pressing *Ctrl+Shift+Enter* (or *Cmd+Shift+Enter* on Mac).

15

16~ """ {r}

17 ggplot(data = mpg) +

18 geom_point(mapping = aes(x = cty, y = hwy), alpha = 0.2)

19- "

3 Insert ~

This is an [R Markdown](http://rmarkdown.rstudio.com) file (it has a .Rmd file extension).
When you execute code within the file, the results appear beneath the code.

| [y

40-
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30-
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Text
Code
Output
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Your turn

@ 01_getting-started.Rmd

. eTa A e Read the instructions

12 This is an [R Markdown](http://rmarkdown.rstudio.com) file (it has a .Rmd file extension).
When you execute code within the file, the results appear beneath the code.
13

14 R code goes in **code chunks**, denoted by three backticks. Try executing this chunk by Ru n the COde Ch u n I( by
clicking the *Run* button (a small green triangle) within the chunk or by placing your cursor

inside it and pressing *Ctrl+Shift+Enter* (or *Cmd+Shift+Enter* on Mac).
15

2 p— = clicking the play button

18 geom_point(mapping = aes(x = cty, y = hwy), alpha = 0.2)
19 "

40-

30-

hwy
eoe
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Add a new chunk

Put 2 + 2inthe chunk and run it
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Render a Quarto document into a standalone shareable file

% | example.gmd*
- 2| |-} [ |RenderonSave Q

Source Visual @ Render HTML

N *=#_ Render PDF

2 title: "Example Quarto fi
3 author: "Me" W Render MS Word

L farmat -
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The best way to combine R code and narrative

We'll use it throughout the class:

I'll provide starter code

You'll complete "Your turns"

In the end, you'll have an annotated record for yourself
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Spot the difference:

filter(mtcars, cyl == 4)

four_cyls <- filter(mtcars, cyl == 4)

Find these chunks in the notebook and run them.

What's different about what happens?
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<- assigns the output from the righthand side to a variable with
the name on the lefthand side

four_cyls <- filter(mtcars, cyl == 4)
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Environment pane

[ ]
. . c . .
Environment History = Connections Tutoria t ,=D. LlSt Of all the

(= 7 Import Dataset ~ {

7 Global Environment ~ Q Variables youlve CreatEd

Data
@ four_cyls 11 obs. of 11 variables

1lf
—
c
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Find four_cy1ls in the environment pane.
Click on the name four_cyls

What happens?
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@ 01_getting-started.Rmd \7\ four_cyls — (0 d bt bt bt
S D! v a Clicking on an object in the
“ mpg cyl disp hp drat wt qsec vs am gear carb
1 22.8 4 108.0 93 3.85 2.320 18.61 1 1 4 1 ) e
2 24.4 4 1467 62 3.69 3190  20.00 1 0 4 2 en"l ronment panel Opens It
3 22.8 4 140.8 95 3.92 3.150 22.90 1 0 4 2
4 32.4 4 78.7 66 4.08 2.200 19.47 1 1 4 1 ° e . b
5 30.4 4 75.7 52 4.93 1.615 18.52 1 1 4 2 a n I nte ra Ctlve VI ewe r ta
6 33.9 4 711 65 4.22 1.835 19.90 1 1 4 1
7 215 4 120.1 97 3.70 2.465 20.01 1 0 3 1
8 27.3 4 79.0 66 4.08 1.935 18.90 1 1 4 1
9 26.0 4 120.3 91 4.43 2.140 16.70 0 1 5 2
10 30.4 4 95.1 113 3.77 1.513 16.90 1 1 5 2
11 21.4 4 121.0 109 4.11 2.780 18.60 1 1 4 2

Showing 1 to 11 of 11 entries, 11 total columns
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four_cyls <- filter(mtcars, cyl == 4)

Functions do things
Functions take arguments, output results

If you want to keep the output, assign it to a variable
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To look up the help page for an R function,
type this in the console:

?function_name

(Or google it!)
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Help pane

Files Plots Packages Help Viewer —m

«ools G ©)C These help pages prove
details about the arguments
you can supply a function

R: Return rows with matching conditions ~  Find in Topic

filter {dplyr} R Documentation

Return rows with matching conditions

Description Often full of examples

Use filter () to choose rows/cases where conditions are true. Unlike
base subsetting with [, rows where the condition evaluates to NA are

at the bottom

dropped.
Usage
filter(.data, ..., .preserve = FALSE)
Arguments
.data A tbhl. All main verbs are S3 aenerics and nrovide methods

26 [ 33



Look at the help page for seq

Add a chunk that uses seq() to create a

list of numbers from 5 to 100, spaced by 5
(so 5, 10, 15, 20, ...)

02:00
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seq(from = 5, to = 100, by = 5)

##  [1] 5 10 15 20 25 30 35 40 45 50 55 60 65 70
## [20] 100
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Common syntax problem #1

Missing closing parentheses or quotes

mean (mtcars

"Oops this is wrong
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Common syntax problem #2

Surrounding something in quotes when it should be (or vice versa)

mean("mtcars")

## Warning in mean.default("mtcars"): argument is not numeric or
## returning NA

## [1] NA
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There are three chunks under "Syntax gone wrong"

Run each, read the error message, and try to fix the syntax
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Cheatsheets

RStudio IDE

Documents and Apps

CHEAT SHEET
Write Code

R Support

Go to Help > Cheatsheets to find quick
reference guides to different packages

-4 g

Pro Features

shared
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o oG] incutent poject
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e el |13 o stars 3
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: Jumpto :umpxl Ru‘n - ‘Pbish Shzwl’le ; ; PROJECT SYSTEM
@ chunc chunkc ine 6 -poasisni L Ait  mouse drag. s of parent emronmans aslistor grid File>New Prolect
2 Access markdown guide at s -Pogsooes” (cdndugnost\(s ina ppear in the magin e C—— Rstudio saves the call history,
.1 Help> Markdown Quick Reference 5 Tl Hova o dagnosic Ao for o - - g e g
Syntax highlighting based roject. It reloads each when
2 Jumpto Setknitr Runthisand Runthis 1 § Functions current project  PrO¥
B chu chunk  allprevious codechunk| [ o2" get fgie < fmctiond ¢ onyour iHesetasen foo fction () pro} You re-0pen a project.
7 options code chunl 413 Crum 3% (10 A m) Tab completion to finish
e RNl bl | sasswdobecsty  Viewinda Viewfuncion [ —
= S T— —
3 ¥ e Wolilargusgecode | T TR =
2 e o 1 e Snippets to quickly use Py e e —y— Navigate  Openin Export ~Delete ~ Delete
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R g 2 Create | Upload Delete Rename | sensoimetmam| Change || [rme—ams s
3 P i @t e folder [fle  fie fie e mamomoon Girectory | | @ @,
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Lt i e Presstosee  Dragpane A browsr keyed toyourworking diectory.
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o el
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Debug Mode Version Control winsicorsw e
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Data basics



